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Chapter 1. Getting Started 

About this guide 

This Evaluation Guide is provided to help Pulsonix users become familiar with the 

concepts and usage of the Pulsonix Database Connection (PDC). 

Installing the PDC demonstration 

The Database Connection demonstration database is automatically installed as part of the 

main Pulsonix application. No additional installation is necessary. 

Enabling the PDC demonstration 

The Database Connection demonstration is automatically enabled whenever you are using 

the ‘Demo’ (Trial) or ‘Viewer’ licenses.  

To use one of these licenses, start the Pulsonix License Manager (from your Windows 

Start menu, under Programs, Pulsonix), click Browse Master File, and choose the 

Demo.Lic or Viewer.Lic files. 

If you have a full product license, when you have finished evaluating the Database 

Connection product you can simply switch back to your full license file using the License 

Manager. 

Finding More Information 

The rest of this guide takes you through the basic features of the Database Connection, 

with step-by-step instructions to guide you through each stage of the process: 

- Overview of how the Database Connection fits into the overall process 

- Searching for components in the database 

- Adding components to a design 

- Checking and maintaining your design 

You can also access context-sensitive online help by pressing the <F1> key at any point. 
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Chapter 2. Overview 

What is the Pulsonix Database Connection? 

The Pulsonix Database Connection (PDC) is an add-on cost option for Pulsonix, that 

allows you to ‘hook up’ your Pulsonix program to your corporate component database, to 

help you find the right components for your designs using parametric searches on any of 

the properties recorded in the database.  

This can help you ensure for example that the components you choose are in stock, or 

reasonably priced, or within required parameters. As long as you have information in 

database form that can be accessed by the Database Connection, you can make use of it. 
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Where does the database come from? 

The Database Connection is not a database itself, rather it is an ‘enabling’ technology that 

allows Pulsonix to interact with corporate information that you would normally be using 

elsewhere. This might for example be a database of Supplier and Component information 

that is already in use in your Purchasing department. 

Although the Database Connection itself does not come with a ready-made database, the 

‘full’ Database Connection license does include tools to help you create a basic database 

from your Pulsonix library data. This process is described in the separate Pulsonix 

Database Connection Users Guide, and can help you get started with a database even if 

you don’t already have one. 
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Chapter 3. Using the PDC 

The Database Bar 

Once Pulsonix is running with the trial license (so that the PDC is enabled), start by 

opening the example Schematic design Inter.sch. 

If you look at the bottom left corner of your main application window, you will see the 

Database Bar tab: 

 

Hover your mouse over the Database Bar tab to make the bar slide out and display the 

dialog. If it isn’t not visible, you can turn it on using the Database Bar command from 

the View menu and selecting Dockable Windows. Remember though, this option is only 

available using the trial license or a PDC license. 

 

Searching 

The central area of the Database Bar is where you select the database table or query and 

enter the criteria you want to use to search for the desired component in your database.  

 

First we need to choose the database table or query to select from. Using the Look In: 

drop down list of table names select Capacitor. 

Press the Search button before entering any criteria, this will show you how an ‘empty’ 

set of criteria will match with all possible records in the selected database table. All the 

records in the Capacitor table will be displayed in the results grid. 
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We can ‘narrow’ down our search by entering criteria and therefore decide what kind of 

capacitor to search for.  

Adding search criteria 

To add to the search criteria you will use the Add button. However, for the first search the 

search row is already available ready to be typed into. 

 

Under the Field heading, use the drop down list to choose VOLTAGE from the list of 

available field names. 

Next, choose the Operator > from the drop down list in the next column. Finally, type 20 

in the Value column. 

 

Click the Search button, the search will be narrowed down to show just 27 items, all 

those capacitors in the table with a Voltage of greater than 20. 

 

We need a 1uf capacitor, so click the Add button again to add another row to the list of 

criteria.  
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Choose Value under Field, then = in Operator and type 1uf  in Value. Click the Search 

button.  

 

When the results are displayed we have just two capacitors to choose from.  

 

Adding Components 

We have narrowed down our search to list only two capacitors that match the 

requirements, we can now select and add some components to the design. 

Click on the first capacitor shown in the results grid (click anywhere along the row to 

select the required capacitor). You will see a preview of the Schematic and PCB 

components that correspond to this database record. 

 

You can now either click Add then move the cursor into the design area and place your 

new component, or move the cursor over one of the preview boxes and ‘pick and drag’ 

the component into the design for placement. 

You can place the new component just as you would when adding components directly 

from the Pulsonix library through Insert Component. As you place each of your new 

components, attributes will be automatically added to those components to hold the 

required database information. 

When you have placed at least three capacitors, press the <Esc> key to stop adding any 

more. 

Check Against Database 

The Check/Update Against Database command, available from the Tools menu, is used 

to verify the information in your design against the corresponding records in the database. 

It can be used to identify differences between design and database values, and can be used 

to ‘refresh’ the values in the design if the database information has been updated. 
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This can help you for example to keep the manufacturer part numbers in your design up-

to-date if these are maintained separately in the database by your Purchasing department. 

Before we use this option, we will change one of our new components to purposely edit 

some ‘wrong’ information in and see what the Check reports. 

Select one of the new capacitors and open the Properties dialog and Comp Attributes 

tab (select the capacitor and click <i>). 

 

You will see the list of attributes that have been brought across from the database record 

onto your component. 

Double-click on the Value attribute and change it to 1pf, and OK to close Properties.  

Select the second capacitor and edit its Properties. This time change the MFR Attribute 

from AVX to TX. Click OK to close the dialog. 

We are now ready to check the design. From the Tools menu, select Check/Update 

Against Database.  

The check dialog is configurable with various options to select: 
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To start with, we will just see what the Check is going to report, so leave the Allow 

Update of Design to Match Database check box (in the top right corner of the dialog) 

unchecked, and check the all other options. Then select Check. 

You should now see a report that lists your components and the status of each one.  

C1     Fail (Value [1pf:1uf]) 

C2     Warning (Mfr [TX:AVX]) 

C3     Pass 

Here you can see that C1 (where we had modified the Value) is listed as a Fail, because 

we have changed an attribute that is specified as Critical in the Database Setup. C2 is 

only a warning, showing we have a different value for a non-critical attribute, and C3 

matches the database record so is shown as a Pass. 

You will also see that the components in the design are highlighted to show their status. 

The default Colour setting is to use red for Fail, orange for Warning and green for Pass, 

giving a rapid visual indication of the status: 

 

Updating the Design 

As well as simply checking the design, the Check/Update command can also ‘refresh’ 

your design to bring it back up-to-date with the values from the database. 

Under Update Design from Database, check the Allow Update of Design to Match 

Database check box: 

 

Once checked, press the Update button. 

You will see a report that is very similar to the first one, but shows you what has been 

changed: 

C1     Fail (Value [1pf:1uf]) UPDATED 

C2     Warning (Mfr [TX:AVX]) UPDATED 

C3     Pass 

The components themselves will all be highlighted in green as they are now all 

synchronized with the database. 
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Change Part using the Database Bar 

As the final stage of our exploration of the Database Connection, we will use it to change 

one of our components for a slightly different one. 

First, select one of the capacitors you earlier added to your design. Select the Properties 

dialog from the shortcut menu and from the Component tab click Change. 

From the Change Part option click Change Database to go to the Database Bar to 

choose your new component. 

 

Database Bar will now appear as a dialog-style window instead of the slide-out panel. The 

Add button has become Change, and Add to Bin is now Cancel. Otherwise the Database 

Bar works in just the same way as it did before. 

You will notice that the Criteria section lists all the details from the selected component as 

possible criteria, and hence matches just a single database record, the one you selected 

when you added the component to start with. 

 

Now we will widen the search to look for a component similar to the one we are already 

using. 

Use the check boxes in the left-hand column next to the Field column to turn off the 

criteria for PartName, Tolerance, Voltage and Supplier, then click Search to scan the 

database. The ‘results’ table will change to show not one but three components. 

 

These match the original (selected) component for Value, but have different Part Name, 

Tolerance and Voltage ratings.  

Select the third one down in the list, you will notice the PCB preview change as it 

recognises that this particular component requires a slightly larger footprint. 

Click Change to choose that one from the database, then OK twice to close out the 

Properties dialogs. 

Your design will now be updated to use the newly-selected component. 
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Summary 

In our brief tour through the Database Connection, we have seen: 

• an overview of what PDC is all about 

• how to add components to a design using the Database Bar, narrowing our search 

down until we find the component that matches our requirements 

• how to verify a design against the current database contents, looking for 

components that may no longer be in line with database information 

• how to update a design with the latest database values 

• how to use the Change option, and widening search criteria to look for alternate 

components 

You will find more detailed information on the Database Connection, including all the 

details on how to set up the Connection to your own corporate database, in the Pulsonix 

Database Connection Users Guide, a PDF document located in the Documents folder 

below your Pulsonix installation (or available for download from our web site). 


